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I. Introduction

Aecrobraking (AB) is a cost effective method for making orbit changes using atmospheric drag. It
has become useful on recent missions for obtaining the desired destination orbit about a given planet for
various scientific motivations. Atmospheric drag is utilized to create an effective AV at the periapsis of the
orbit and thusly reduces the apoapsis altitude and velocity. Atmospheric drag during AB is created by the
spacecraft passing through the upper atmosphere of a planetary body at hypersonic speeds. In all AB
missions to date, the solar arrays on the spacecrafts have been used as the primary drag surface. The
amount of effective AV created by passing through the atmosphere can be controlled by the depth of the
drag pass into the atmosphere and the length of the drag pass. However, for an increase in atmospheric
density and pass duration, the incident heat flux on the spacecraft and its solar arrays is greatly increased.
As expected, an increase in the incident heat flux results in higher temperatures on the solar arrays. In AB,
predicting these temperatures is imperative given the solar arrays’ finite thermal limit.

The first application of AB took place in 1993 during the Venus Magellan mission'. This
application was referenced as a “Transition Experiment” being the first of its kind and was not necessary
for mission success. The reason for AB in this mission was to reduce the highly elliptic insertion orbit so
that the resolution of the gravity data being collected would be increased at non-equatorial regions for the
proposed experiment. During AB, Magellan’s orbit was reduced from an eccentricity of 0.3 to 0.03 over a
period of 70 days and 750 orbital passes. This experiment essentially reduced the orbital velocity by 1,221
n/s while only using 31.6 kg of fuel. The Magellan spacecraft is shown below in Figure 1. Throughout AB,
the solar arrays were oriented normal to the aerodynamic flow to increase the drag surface. This AB
configuration placed the large High Gain Antenna behind the spacecraft bus to ensure longitudinal stability
while in the atmosphere”. It is important to note that for this and all subsequent missions that the spacecraft
was oriented so that the backside of the solar panels rather than the cell side faced the aerodynamic flow.
For the early AB design phase of Magellan, the heating rate was the primary upper design limit. However,
a dynamic pressure constraint was also introduced to keep the attitude rates small in case of a sideways
entry. At the time of AB, the Magellan spacecraft only had a total of four temperature sensors that would
aid in temperature prediction for the solar panels. These sensors were located on the front side of the solar
panels’. By today’s standards, a rudimentary finite element model of the entire spacecraft was utilized to
predict the maximum temperatures experienced by the solar panels. This method most likely contained
significant errors due the computational capabilities available at the time*. While AB was not essential to
mission success for Magellan, it was so for the subsequent AB missions: Mars Global Surveyor (MGS),
Mars Odyssey, and Mars Reconnaissance Orbiter (MRO).

MGS, the second application of AB, saved approximately 1,220 m/s of impulsive AV by AB for
over 850 passes. AB was necessary on this mission for the spacecraft to reach the desired science orbit.
This spacecraft can be seen in Figure 1 in its AB configuration. As can be seen in the diagram, drag flaps
were added to the ends of the solar panels to increase the overall drag of the spacecraft when in its AB
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configuration. During AB, the solar panels were to be swept back by 30 degrees to assure aerodynamic
stability. However following launch, it was discovered that one of the solar panels did not fully deploy and
was thus tilted by approximately 20 degrees. This phenomenon added a new element to this AB mission.
To proceed with AB, the broken solar panel was aligned with the cells and directed into the aerodynamic
flow. While the AB could continue, a much lower dynamic pressure constraint was introduced causing the
AB phase to require an additional year’. MGS had four thermocouples located on its solar panels. Two of
the sensors were on the cell side of the panels, and two were located on the “hot” side or the side facing the
aerodynamic flow. These thermocouples were used as an input to a 1-dimensional thermal analysis that
determined the heat rate that the solar arrays experienced during previous drag passes’.

Mars Odyssey, currently the most aggressive AB mission, saved an effective impulsive AV of
approximately 1,090 m/s over 300 AB passes to enter into a 400 km circular orbit. The spacecraft is shown
in Figure 1 in its AB configuration. As with the previous AB missions, Odyssey was oriented so that the
cell side of the solar arrays faced away from the flow. This configuration results in a high stability about
the body z-axis which nominally points towards the center of Mars during AB”. As can be seen in the
diagram, the solar array is a three panel, layered construction. Five temperature sensors were utilized in the
thermal analysis of the solar panels during the AB phase. Two of the sensors are located on the exposed hot
facesheet side, while the other three are located on the cell side. The thermal analysis method used during
operations for Mars Odyssey AB exceeded prior methods in its accuracy by utilizing a 3-dimensional finite
element thermal model to predict solar array temperatures for future drag passes as well as reconstruct the
temperatures from past orbits*. Further details into this thermal analysis method and the actual sensor
locations will be discussed in detail in subsequent sections.

The most recent AB mission, MRO, which attained its science orbit in August 2007, performed
450 AB passes to circularize and reduce its orbit about Mars and in turn saved approximately 1,190 m/s of
impulsive AV. The spacecraft’s AB orientation can be seen in Figure 1. MRO is the first multiple pass AB
spacecraft to have a nearly asymmetric AB configuration. Utilizing the HGA as an additional drag surface
does introduce a bias in the spacecraft’s angle of attack but also increases its stability”. MRO had a
significant increase in the number of temperature sensors on the solar arrays. A total of eight sensors with
four on the hot side and four on the cell side were located on the spacecraft’s solar panels. Also, the sensors
were placed in locations where the highest temperatures were expected. These improvements in planning
allowed for a more accurate and credible thermal analysis of the solar panels. A new probabilistic thermal
approach was used on MRO during AB operations. This approach uses a high fidelity finite element
thermal model to create a thermal response surface. The response surface methodology reduces the
complex 3-dimensional thermal model into a simple equation that can be used to predict the temperatures at
various locations on the solar arrays. Further, a Monte Carlo analysis was used to give a mean temperature
prediction as well as a standard deviation from which +3c uncertainty bounds were calculated’. As this is
the method being applied to the Mars Odyssey mission in this project, it will be explained in much more
detail in the following sections.
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Figure 1. Aerobraking missions

As evidenced in the all of the multiple pass AB missions above, much concern has been placed on
predicting accurate solar array temperatures during operations. This process has proved to be a difficult
endeavor due to the various uncertainties involved in an AB thermal analysis. The probabilistic method that
was previously mentioned as being used for the MRO mission provides a very useful and efficient way of
incorporating such uncertainties and determining solar array temperature predictions. This thermal response
surface methodology can include environmental uncertainties in the solar array’s expected heat loads as
well as physical uncertainties associated with the geometry and composition of the spacecraft and solar
arrays. The primary environmental uncertainty that has been identified is the density variability in the
Martian atmosphere. In addition to environmental and physical uncertainties, computer modeling
uncertainties from numerically modeling physical components can also be included in the analysis. Using
this method, the most significant uncertainties can all be included in designing the thermal response surface
for an AB mission. The response surface equation is most useful when utilized in a Monte Carlo simulation.
By statistically varying specific parameters to be used in a single repeated calculation, the Monte Carlo
simulation can determine a mean predicted temperature, a standard deviation in the temperature estimation,
and the probability of falling within the £3c temperature bounds. Using a simple response surface equation
rather than a high fidelity finite element model for the Monte Carlo simulation makes this type of thermal
analysis practical for temperature predictions during AB operations.

II. Motivation

As addressed in the previous section, a probabilistic thermal prediction model is a necessary
component for a safe and robust AB mission. Furthermore, the model needs to perform fast enough so that
a full thermal analysis of the solar array can be performed during each drag pass of AB operations. For
Magellan and MGS, the thermal models were quite rudimentary compared to the 3-dimensional finite
element thermal models utilized directly on Mars Odyssey and indirectly on MRO. Mars Odyssey was the
first AB mission to attempt using a complex model to predict temperatures on the solar array for future
drag passes as well as reconstruct temperature distributions for past passes. This method resulted in the
detailed temperature distribution predictions seen below in Figure 2. While this method was a vast



improvement over those used in previous AB missions, it was a somewhat slow process and provided no
method for determining uncertainties in the predictions as well as for calculating the probability of the
actual temperature falling within a £3c temperature bound of the estimate. Performing such studies with
the high fidelity model would have been extremely time intensive requiring approximately 10,000 hours for
a 10,000 case Monte Carlo simulation of one drag pass’.
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Figure 2. Predicted temperature distribution on the solar array6 (drag pass 40)

However, since this detailed analysis was performed for each orbit during operations, it makes Mars
Odyssey a prime candidate for testing and studying the probabilistic thermal model that utilizes a response
surface equation in place of the high fidelity 3-dimensional finite element model. The model used during
Odyssey AB operations also provided hot spots and maximum temperatures on the solar arrays independent
of the temperature sensor locations. While the response surface methodology has been applied to the MRO
mission, 3-dimensional finite element thermal model predictions do not exist for each orbit during MRO
AB.

Another motivation for applying the response surface methodology to the Odyssey mission is
because of its aggressive AB. Compared to Odyssey, MRO was a fairly benign and far less aggressive AB
mission. During Odyssey AB, a maximum solar array temperature was estimated to reach 90°C on orbit
106 while MRO’s peak solar array temperature was estimated to reach only 40°C. This aggressive Odyssey
AB will no doubt push the solar array temperatures much closer to their thermal limit. Attaining £3c
uncertainty bounds and the probabilities associated with the bounds will provide great insight into the
robustness of using a probabilistic thermal prediction model.

ITI. Development of Method

Applying a probabilistic thermal analysis to Mars Odyssey AB requires the use of high fidelity 3-
dimensional finite element model. This type of model was used for determining the thermal limits during
the design phase of the mission and for temperature predictions during AB operations. For this study, the
high fidelity model was used to create a response surface model of solar array temperatures at specific
locations. This response surface model can then be utilized in a Monte Carlo simulation to obtain a mean
temperature estimate along with a standard deviation of the estimate for positions on the solar array. As
mentioned before, the Monte Carlo simulation can also provide a probability of the temperature being
within a specified corridor.

The high fidelity thermal model used to create the response surface is strategic in the accuracy of
the response surface temperature estimates. Three primary components comprise the thermal model used
on Mars Odyssey. The Thermal Desktop model is the first of these components and is used to determine
radiation view factors and the orbital heating for each drag pass. The second component is the Patran
Thermal finite element model which is used to calculate the solar array temperatures encountered during



each drag pass. The Thermal Desktop model and Patran Thermal model of Mars Odyssey used in the
thermal analyses are shown below in Figure 3.
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Figure 3. Thermal Desktop model (left) and Patran Thermal model (right) of Mars Odyssey

A Direct Simulation Monte Carlo model of the Odyssey spacecraft and solar arrays is the third component
and is used to calculate the heat transfer coefficients as a function of the atmospheric density. A sample
heat transfer coefficient distribution on the Mars Odyssey solar arrays for a density of 32 kg/km® is shown
below in Figure 4. Also in the figure below, the approximate temperature sensor locations are identified. As
shown, sensors one and four appear on the hot facesheet side, and sensor two, three, and five appear on the
cell side. These locations are important in this study as they are the primary source for validating the
proposed thermal analysis method.
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Figure 4. Odyssey heat transfer coefficient distribution with temperature sensor locations for a
density of 32 kg/km®
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The boundary conditions for the thermal model come from the provided POST trajectories as well as the
Thermal Desktop and DSMC outputs. The three primary components of the high fidelity thermal model
used during Odyssey AB operations can be combined to predict temperatures on the spacecraft’s solar
arrays. A sample temperature distribution using this methodology can be seen by referring back to Figure 2.
As is evident by viewing the distribution, the temperature sensors were placed in rather poor positions for
determining the maximum temperatures on the solar arrays. For this particular orbit, the thermocouples
indicated temperatures around 0°C while there are obviously locations on the facesheet side of the array
that reach temperatures near 50°C. These errant sensor positions further necessitate an accurate and robust
thermal model for determining maximum temperatures.



During Odyssey AB operations the thermal model was correlated to flight data. Doing this
revealed that the error in the temperature predictions was directly related to the uncertainties in the density
profile predictions. An error in the predicted density profile will lead to errors in both the predicted peak
heat flux reached and total heat load; both of which will lead to inaccurate temperature predictions. This
large variation in the density profile from the assumed normal distribution can be seen in Figure 5 for an
individual orbit.
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Figure 5. Mars Odyssey density profile for orbit 157

In addition to density uncertainties, many other uncertainties contribute to unreliable solar array
temperature predictions. A new and more useful method of temperature prediction was deemed necessary
and was utilized for MRO AB operations. This method, as previously mentioned, utilizes a Monte Carlo
simulation to statistically vary inputs into the thermal model and thus provides a way of quantifying the
uncertainties involved in the thermal predictions and calculating the probability of exceeding a thermal
limit. This type of Monte Carlo simulation cannot be simply applied to the high fidelity thermal model used
for Odyssey operations because of the length of time involved in predicting the solar array temperature
distribution for each case. As mentioned before, one set of predictions would require approximately 10,000
hours for a 10,000 case Monte Carlo simulation. To make a Monte Carlo simulation practical, temperature
predictions must be calculated in a few seconds rather than several hours. Using a thermal response surface
model in place of the high fidelity thermal model, allows for the necessary rapid temperature predictions.

A response surface equation can appear in various mathematical forms. For this study, a
polynomial equation was used. The general form of a polynomial response surface equation can be seen
below with both the two and three-variable interactions. The primary reason for choosing a polynomial
equation for this study is that this form can be evaluated several times per second as opposed to a more
computationally demanding form. Also, the actual equation used in the Odyssey temperature prediction
only involves the two-variable interactions.
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In the response surface equation used for this analysis, the dependent variable is the temperature of
the solar array at a specific location. Since, there are five sensor locations and a maximum temperature
being calculated, six separate response surface equations were required. Deciding which independent
variables to include in the equation is a matter of determining which variables have the most effect on the
temperature of the solar array. This is typically done by a group of discipline experts brainstorming about
the various affects on solar array temperatures during AB. While this is the most commonly used method
for this type of analysis, it is also the most subject to error as an important variable may be inadvertently
omitted. Ideally, a sensitivity analysis would be performed to determine the variables that most impact the
dependent variable. This type of study would also reveal any correlation between variables. However, a
sensitivity analysis of this style is extremely time intensive and not practical for this study. In this case, the
discipline experts included those responsible for the development, use, and correlation of the thermal
models for both MGS and Mars Odyssey”. The independent variable results that were used for this Odyssey



response surface development were originally determined for use during MRO AB. Since the AB portions
of the two missions were similar, these variables were determined relevant for use with Odyssey AB data.
While a response surface equation would be the most accurate if each and every temperature impacting
element were included, each additional variable greatly increases the number of Patran Thermal runs
required. An increase in the Patran Thermal runs greatly increases the time required for building the
response surface. Therefore, the 15 independent variables selected for the study are displayed below in
Table 1 alongside their 36 uncertainty as estimated by the panel of experts. The response surface bounds
column of the table displays the upper and lower bounds used for each variable when building the response
surface. 60 was used for all variables where such values were realistic. +56 was used for the variables
where 66 exceeded the possible range such as when the emissivity value goes above 1. The chosen
factors are divided below into environmental factors, material property factors, and modeling factors.

Table 1. Odyssey analysis variables used in developing the response surface equation

30 Response
Category Factor uncertainty Surface Distribution
Bounds
Environmental Drag pass duration 3% +6c Normal
Density +30% +6c Normal
Heat transfer coefficient +14% +6c Normal
Periapsis velocity +0.05 km/s +6c Normal
Initial solar array temperature +20°C +6c Normal
Orbital heat flux +30% +6c Normal
Material MS551J graphite emissivity +4% +6c Normal
Property ITJ solar cell emissivity +5% +6c Normal
MS551J graphite thermal conductivity +25% +6c Normal
MS551J graphite specific heat +15% +6c Normal
Aluminum honeycomb core thermal conductivity +30% +6c Normal
Aluminum honeycomb core specific heat +5% +6c Normal
Modeling Outboard solar panel mass distribution +50% (x60) Normal
Solar cell layer mass distribution +10% (£60) Normal
Contact resistance between panel layers +50% +6c Normal

As mentioned above, the number of Patran Thermal runs must be minimized to create the response
surface in a practical amount of time. The best way to do this is using a statistical design of experiments
(DOE). The most thorough method is the full factorial design in which all variable combinations are
analyzed. However, this can result in far too many Patran Thermal runs to make it practical for this study.
For the 15 selected factors with three levels (high, low, and midpoint value) each, a full factorial analysis
would result in 3'5 or 14,348,907 Patran Thermal runs. A full factorial analysis increases exponentially
based on the number of variables and levels making this method entirely impractical. However, a statistical
software package, JMP, allows for various DOE’s that minimize the number of required runs. To allow for
a more timely processing time, JMP was used to form a face centered central composite design. Using the
face centered central composite design, the number of runs could be drastically reduced while maintaining
an acceptable degree of accuracy. For the 15 independent variables with three levels each, the number of
Patran runs was reduced from 14,348,907 to 296 by using the face centered central composite design. To
further increase the accuracy of this methodology, the peak density was handled as three completely
separate response surface equations and was then varied on a smaller scale within each response surface.
This was done to reduce the impact of the large variance in peak density throughout the mission. Thus, for
the full range of density values, 888 cases are required. After running each of the three sets of the 296 runs
where the 15 variables were set to different combinations of values, the maximum temperatures for each of
the five sensor locations along with the maximum temperature for the entire array were entered into JMP.
Then, using JMP’s step-wise regression function, the coefficients to the response surface equation were
determined. These are represented by the letter b in equation 1.

After obtaining the response surface equations, the final step in the probabilistic thermal analysis
approach is to perform a Monte Carlo simulation. The most difficult part of performing the Monte Carlo



simulation is determining the uncertainties for all of the variables. As with determining the 15 response
surface variables, the MRO uncertainty values were utilized and simply applied to the Mars Odyssey AB
mission. For MRO, the drag pass duration, atmospheric density, heat transfer coefficient, and periapsis
velocity uncertainties were determined by analyzing past Mars AB mission data and calculating the mean
and standard error of the data for each. This is the best and most accurate method for determining the
uncertainties and was therefore used for these integral analysis variables. However, the remaining 11
variables’ uncertainties were approximated by expert judgment. Using expert judgment as opposed to the
more rigorous method can lead to increased error in the Monte Carlo results. Therefore, very conservative
estimates were used for these remaining variables to increase in the fidelity of the results. The following
sections will provide detailed instruction on implementing this study and on utilizing the required analysis
tools.

The flow of the entire study is represented in Figure 6. The left side of the diagram lists the
various analyses and files that are required for input into Patran and the response surface. As shown, JMP is
utilized to generate the cases for Patran. Patran is then used for estimating the temperature profiles for the
specific cases. These temperatures are then fed into JMP where the response surface equation is generated
using stepwise regression of the data. Finally, the response surface equation is utilized in a Monte Carlo
analysis to generate estimates of maximum temperatures for the Odyssey solar panels as well as the
probability of exceeding the thermal limit of the panels.
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Figure 6. Flow of Required Analyses for the Study

IV. Instruction on the Creation and Modification of Required Files for Patran
Many files are necessary for producing a temperature prediction profile for a specified Odyssey
drag pass using Patran. Foremost is the finite element model of the solar panel. The Odyssey finite element
model is called mars_ody rev5.db. In addition to this model, several other data files are required by the
Patran simulation. These files include the DSMC data files for accounting for the heat transfer coefficient,
trajectory files, orbital files (view factors and orbital heat flux) obtained from Thermal Desktop, material
property files, Fortran code for modifying the solar heat flux, initial temperature files, and files associated



with modeling uncertainties. In addition to these data files, there are several Patran required control files
and drivers necessary for proper execution. In addition to nominal files, off-nominal versions of the data
files were also created to accommodate the high, mid, and low variable variations. Figure 7 displays the
various files and the files respective names that are required by Patran for producing the case specific
temperature profiles. In the filenames that have a ‘z’, the ‘z’ represents the nominal version of the file or
variable associated with the file. A ‘pl’ or ‘ml’ can replace the ‘z’ for high and low cases, respectively.
The ‘z’ represents zero, the ‘pl’ represents plus one, and the ‘ml’ represents minus one. The following
sections will explain how these files were obtained or constructed.
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Figure 7. Files Required for the Operation of Patran

A. Heat Transfer Coefficients Using DSMC Data

The Direct Simulation Monte Carlo files needed by Patran were obtained from aeroheating data
provided by Dick Wilmoth. These files were then modified to the format required by Patran. This
processing also involved mapping the heat transfer coefficients to the proper mesh for the Odyssey model
and then varying the nominal heat transfer coefficient files to accommodate the high and low cases for the
response surface. This process was performed using a Tecplot macro entitled newmesh _DSMC.mcr.
B. Trajectory Files

Five Odyssey-like trajectories are required for this study. Three are required for the cases needed
to build the response surface, and all five are utilized for a fitting initial temperature to orbital period for the
Monte Carlo analysis. The process involving the five orbits and curve-fitting the data for use in the Monte
Carlo analysis will be explained in the section detailing the Monte Carlo simulation. The orbits were
obtained using POST and provided by Jill Prince. In addition to the time based trajectory data, orbital
elements for each of the orbits was provided for use in the Thermal Desktop analysis below. These
nominal trajectory files then are modified to represent high, mid, and low variations in drag duration, peak
density, and maximum velocity. For three nominal orbits, 27 trajectory files are needed for the specified
variations. An Excel spreadsheet entitled RS traj ody.xls is used to modify and create the necessary files.
C. Orbital Files Obtained Using Thermal Desktop



The view factor and orbital heating files used in Patran are created using Thermal Desktop. The
Thermal Desktop model of the Odyssey spacecraft is MSP 01 stow.dwg. To use this model, the short,
medium, and long drag pass duration orbits must each be loaded into Thermal Desktop using the orbital
elements provided with the trajectory data. The menu for entering the Keplerian orbital elements is
accessed from >Thermal>Orbit>Manage Orbits. From this menu a new orbit can be added using the
specified orbital elements. When entering the Right Ascension of the Ascending Node, note that the value
must be converted to International Astronomical Units (IAU) using the internal conversion function. Also
note that the Right Ascension of the Prime Meridian is not used and thus is arbitrary. Under the Orientation
tab, verify that there are additional rotations of -90° about the z-axis and 180° about the x-axis. These
rotations are controlled by the internal slew-to-aerobraking commands. In addition, the orientation should
be referenced by +Z pointing in the Nadir direction. The Planet Data tab should be set as is shown in Figure
8. The Radius of Planet value can be slightly modified so that the periapsis and apoapsis altitudes under the
Keplerian Orbit tab match the values provided with the orbital elements.
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Figure 8. Thermal Desktop Planet Data Settings

Selecting the true anomalies under the Positions tab that correspond to the orbit positions to be
analyzed is dependent on the orbit and requires some additional investigation to determine adequate values.
To obtain sufficient data, orbit positions were chosen that represent 5 minutes prior to crossing into shadow,
just prior to crossing into shadow, shadow entry, directly after shadow entry, periapsis, just prior to shadow
exit, shadow exit, and directly after shadow exit. For determining proper true anomaly values
corresponding to specific times in the orbit, a Matlab file, time2trueAnomoly.m was created that converts
between true anomaly and time. Another easy way to obtain this correlation in Thermal Desktop is by
highlighting the orbit and typing ‘list’ into the command prompt. This then prints the time and true
anomaly for each of the specified orbit positions.

Once the orbits are loaded into Thermal Desktop, the view factor and orbital heating files can then
be created. For creating the view factor files, select >Thermal>Radiation Calculations>Calc View Factors.
Once the software has finished processing the view factor information, create a new post processing data
set by selecting >Thermal>Post Processing>Manage Datasets. Then, a new Form Factor data set can be
created based on orbit and orbit position. This process must be done for each position in each orbit. When
creating the post processing data set, make sure that the Fij/Bij to space flag is set under A/l node data.
Finally, the view factor data must be exported from Thermal Desktop for use in Patran. To do this, select
>Thermal>Export>Write Node Information, and write to file the Node Locations and the Current Post
Processed Data for All nodes. A very similar process is followed for producing the orbital heating files. For
calculating the heating rates, select >Thermal>Radiation Calculations>Calc Heating Rates Ray Trace.
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The Thermal Desktop Post Processing and Exporting of the data for the heating rate files is done as it was
for the view factor files. For more details, refer to the Appendix under the section supplied for running
Thermal Desktop.

The view factor and orbital heating files still require additional post processing after they have
been exported from Thermal Desktop. This process is done using a set of Matlab files and Tecplot macros.
The files have to first be modified using Matlab so that they are in the format needed by the mapping
macros. These initial m-files are entitled read 2 text VF.m and read 2 text HTG.m for view factors and
orbital heating. The Tecplot macros used to map the data to the proper mesh are entitled hot Macro.mcr
and cell Macro.mcr as there is needed a mapping for the files representing the cell side and the hot
facesheet side of the solar arrays. It should be noted that there are separate macros of the same titles for
view factor data manipulation and orbital heating data manipulation. Finally, the data files are converted to
the  format required by Patran using Cell VF afterMacro.m, Hot VF afterMacro.m,
Cell HTG afterMacro.m, and Hot HTG afterMacro.m. This entire process must be performed for each of
the positions in each of the orbits being used in Patran.

Another file that is required by Patran is setup tr.dat. This file simply provides the Patran
simulation information regarding the time tags associated with the view factor and orbital heating files.
This file includes the periapsis time as well as the times of the other selected orbit positions.

D. Material Property Files

The material properties that are varied in the Patran cases for building the response surface are
emissivity, thermal conductivity, and specific heat. The baseline or nominal emissivity data is contained in
the optical.prp file. These files are modified by simply changing the emissivity values associated with the
M55 graphite or the ITJ solar cell for the +6c response surface bounds. This results in nine separate
emissivity data files. The thermal conductivity and specific heat values for the M55J graphite and the
aluminum honeycomb core are found in the file matdat.dat. The changes necessary to accommodate high,
mid, and low values for all for of the variables result in having to create 81 different matdat.dat files with
several modifications in each file. The tables requiring modification for M55J thermal conductivity
uncertainty are 10401 and 10402. The table needing modification for M55J specific heat uncertainty is
10405. The tables needing modification for the aluminum honeycomb core thermal conductivity
uncertainty are 10101, 10102, 10111, 10112, 10121, 10122, 10141, and 10142. The tables needing
modification for the aluminum honeycomb core specific heat uncertainty are 10105, 10115, 10125, and
10145. Due to the large number of modifications, a Matlab file, TCandSH_builder.m, was created to
implement and generate the various modified files. However, the m-file does require the user to calculate
the 60 values for each variable.

E. Fortran Code for Solar Heat Flux Accommodation

The solar heat flux is controlled in Patran using Fortran code. This code is in the file u/ib.lib and
needs only a multiplication factor applied to the solar heat flux calculations to vary its value as required in
building the response surface equation with +6c bounds.

F. Initial Temperature Files

The initial temperatures used by Patran are contained in a binary file called restart.nrf. This file is
created by Patran and is necessary for obtaining an accurate temperature profile. To create the file, it is
necessary to run a Patran simulation starting at a point in the orbit that is at least 5 minutes prior to when
the actual Patran run will begin. When doing this, it is necessary to comment out the line in the Patran
driver file, gin.dat, that reads the restart.nrf file. Doing this globally sets all of the nodes to 0°C at the
beginning of the simulation. The additional time at the beginning of the orbit allows the spacecraft to reach
a steady state temperature prior to the drag pass. When Patran is executed, restart.nrf files are created at 10
sec increments. So, the initial temperature file that corresponds to the time that the actual Patran simulation
will begin can be obtained for each of the orbits. This file then needs to be further modified for the
uncertainties in predicting the initial temperature by creating the high and low restart.nrf files. This is done
by first converting the binary files to ASCII files. This conversion can be done by typing ‘patq’ from the
command line. After selecting option 6, there is an option to convert output files from binary to ASCII
format. The data in the restart.nrf file can then be modified for the uncertainty in the initial temperature
using a Fortran macro called nrMod.exe or by other, more basic, methods. Then by typing ‘patq’ from the
command line again and choosing the appropriate options, the file can be converted back to a binary format.
G. Files Associated with Modeling Uncertainties

Several uncertainties are created in the modeling of physical properties. To account for these
errors in building the response surface, these uncertainties must be modeled. The primary modeling errors
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that are included in this study are contact resistance between panel layers, outboard solar panel mass
distribution, and solar cell layer mass distribution. These variables must be accounted for from within
Patran. For varying each of these parameters, the Patran model mars_ody rev5.db must be opened in the
Windows version of Patran. For modifying the contact resistance, select the Loads & BC tab and switch the
Action to Modify and the Object to Convection. Then select hot _facesheet to_core and modify as required.
The same must then be done for the core to upper facesheet. For varying the facesheet thickness, select
the Properties tab and switch the Action to Modify. Then select graphite epoxy standard and modify the
value associated with the shell corner thickness. For varying the solar cell thickness, select the Properties
tab and switch the Action to Modify. Then select Ga-As and modify the value associated with the shell
corner thickness. Once the changes have been made to the three variables, switch to the Analysis tab, enter
a descriptive job name and click Apply. This will then create a directory with the necessary files for running
Patran for the specified combination of variable values. Also, the primary Patran driver file gin.dat is
created during this process and is thus associated with the specified combination of modeling uncertainties.

V. Methodology for Running Patran in Windows

Once all of the files have been created and modified as needed to cover the bounds of the response
surface, the Patran runs can be performed as specified by the face centered central composite experiment
design. The list of these cases is located in RUN_Options.xls. The High, Mid, and Low tabs represent the
high, mid, and low density response surfaces with the column headers located in the Column Names
worksheet. A Matlab file DOS create.m is then used in conjunction with the case listings to create a batch
file that autonomously cycles through and processes the 888 Patran runs. Great care should be taken when
using this m-file as a wrong variable can yield the response surface invalid. The batch script simply copies
the case specific files from the library of files created in Section IV into a run directory and then executes
the Patran run commands producing the temperature profile for that particular case. This temperature
profile for the various solar panel locations is located in the output file trans.01. This file is then used in
conjunction with the case listing to build the response surface.

VI. Creating Response Surface Equations Using Patran Output

The trans.01 Patran output temperature profile is then used directly in the creation of the response
surface equation. However, only the maximum temperatures from each drag pass are needed for the
response surface. These maximum temperatures are extracted from each temperature profile and placed
into an Excel spreadsheet based on case number using a Matlab file called trans2maxtemps.m. The
maximum temperature data is then copied into a JMP file where the cases are listed with the variable
settings for each case. /5 factor CCD.jmp is an example JMP file used for this type of analysis. Once the
maximum temperature data is loaded into JMP, select the Analyze tab and choose FitModel. Be sure to
remove all but one variable from the Pick Role Variables listing. The statistical analysis is then performed
by selecting RunModel and then Go. This produces a table of ‘Estimates’. These ‘Estimates’ will be used as
the coefficients for the response surface. Be sure to extract these estimates at this point and place them into
an Excel sheet for use in the Monte Carlo analysis. The RMS of the Error and the R? adjusted values can
also be obtained by selecting MakeModel and then running the model with Standard Least Squares. These
values are a good indication of the response surfaces fit to the temperature data. Also, a graphical
representation of the response surface’s match to the data is provided in JMP with an Actual vs. Predicted
Plot as shown below in Figure 7.

12



250
g 200
180 e ]
i3]
2B
100
50
| ! | ! | ! | ! | !
s0 100 150 200 250 300
TS2 Predicted P=.0001 RSg=1.00
RMSE=1 9271

Figure 7. JMP Response Surface Equation Accuracy

VII. Performing the Monte Carlo Analysis

The Monte Carlo portion of this project takes a combination of parameters based on a per orbit
basis and parameters that do not vary between orbits. The orbit dependent variables are drag pass duration,
peak density, periapsis velocity, and orbital period. These variables are entered on a per orbit basis into the
Monte Carlo driver RespSurf Driver ODY.m. This driver calls the function located in
RespSurfaceTemp ODY.m. This function performs the proper variable dispersions required for the Monte
Carlo analysis. The function is also responsible for reading and processing the response surface equations.
However, the response surface coefficients must first be loaded into a mat-file for use in this routine. This
is done using the Excel spreadsheet containing the response surface coefficients and a matlab file called
Create_ODY Coeff.m. This file simply reads the Excel data a places it into a mat-file with the proper
format and data orientation.

A few subtleties must be pointed out with regard to this Monte Carlo analysis. The first
noteworthy point is the use of orbital period as an input parameter. This variable is used indirectly within
the response surface. Initial temperature is the actual parameter used in the response surface equation. But
because it is very difficult to predict initial temperature, a more easily predicted variable was chosen that
can be used to define the initial temperature. This process is done by fitting the initial temperature to a
polynomial equation with orbital period as the independent variable. It is important to note that this
equation is in no means general and must be created for a particular mission occurring at a particular time.
Fitting this data is a quite involved process requiring many of the tools used for producing the temperature
profiles cited above. To obtain a useful and accurate equation, five representative Odyssey-like orbits are
used. For each of these orbits the orbital files containing the view factor and heating rate data must be
created using Thermal Desktop. This process is identical to that which was described in Section IV.C. Also,
Patran must be utilized to produce temperature profiles for each of the orbits. It is important to note that all
other parameters that were varied for building the response surface should be implemented with their
nominal value. The process for running Patran was described in Section V and is applicable to this specific
analysis. Once the temperature profiles are obtained, the initial temperature can easily be extracted for each
orbit. Using the initial temperatures and corresponding orbital periods, a polynomial curve-fit can be
performed to produce an equation that is easily entered in to the Matlab file used for the Monte Carlo
analysis.

Also, it is important to comment on the thermal model correlation error used in
RespSurfaceTemp ODY.m. These values correspond to the error and standard deviation of the models
ability to predict accurate temperatures. For the first three or four orbits, these values should be based on
the temperature prediction capability of the response surface based on the data used to create the response
surface in JMP. These values are easily obtained in JMP as described in the previous section. After the first
several orbits, the error and standard deviation values can be calculated by comparing the output of the
Monte Carlo analysis to flight data.

In the end, the Monte Carlo driver is used to produce a mean or predicted temperature and the
standard deviation of the temperature. By keeping up with the output values from the various parameter
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dispersions, a probability of exceeding a specified corridor can easily be obtained. This type of analysis is
very useful in pre-mission planning.

VIII. Conclusion

Further development on this approach could include a detailed analysis of response surface
parameters. For this study, the variables chosen for MRO were utilized and applied to Odyssey to
determine the sensitivities of this approach on a more aggressive AB mission. A more discerning selection
of response surface parameters could greatly reduce the number of required cases for determining the
equation coefficients. Strategically reducing the number parameters would in turn reduce the time involved
in the response surface development without degrading the fidelity of the model.

The probabilistic thermal analysis approach outlined in this paper is integral in moving towards a
more cost-effective, autonomous AB approach. Such an approach for thermal modeling greatly reduces the
processing time during operations for predicting adequate solar panel temperatures and ensuring a safe and
benign mission. As this process was first developed and used during MRO AB, this study is extremely
important in determining the robustness and applicability of this approach to future AB missions.
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Appendix

Process for running Thermal Desktop

1. >Thermal>Orbits>Manage Orbits.... Then add a new orbit using the Keplerian Orbital
elements...note: Convert to IAU and additional rotations....also, planet and sun position is
controlled by RA of Sun.....Then set current

2. >Thermal>Radiation Calculations>Calc View Factors

3. >Thermal>Post Processing>Manage Datasets>Add New>choose Form Factors>Select appropriate
database

4. >Thermal>Export>Write Node Information>write to file

5. >Thermal>Radiation Calculations>Calc Heating Rates Ray Trace

6. >Thermal>Post Processing>Manage Datasets>Add New>choose Heating Rates>Select
appropriate database

7. >Thermal>Export>Write Node Information>write to file

note: orbit times for setup file are in “times.dat”
note: once all view factor and heating rate data has been exported from TD, they must be renumbered and
then mapped to the appropriate ODY node locations.
- mapping done using “read 2 text VF.m” then use tecplot macro “ho¢t Macro.mcr” then use
matlab code for proper formatting “Hot VF afterMacro.m”.

Process for running Patran from the command line:
- Refer to batch scipt located in Odyssey _test directory.....These are created using Matlab code

“DOS_create.m” in MatlabCode on Jump.

Process for running Patran from Windows:
- Use “mars_ody_rev5.db”

- To create Patran files refer to notes located in red notebook or the following
Use mars_ody_rev5.db
For varying ‘A’ (contact resistance):
- Loads & BC
->Action->Modify
Object->Convection

1) - select hot_facesheet to core
- mod data(z=52;m1=10.4;p1=93.6)
- Apply
2) - select core_to_upper_facesheet
- mod data(z=26;m1=5.2;p1=46.8)
- Apply
For varying ‘B’ (facesheet thickness):
- Properties

->Action->Modify
Select graphite epoxy standard
Mod shell corner thickness (z=0.0001905;m1=0.0000381;p1=0.0003429)
Okay and Apply
For varying ‘C’ (solar cell thickness):
- Properties
->Action->Modify
Select Ga-As
Mod shell corner thickness (z=0.0005715;m1=0.0004572;p1=0.0006858)
Okay and Apply
To Analyze:
- Analysis
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Job name->ODY RS z z z
Apply

Shows up in directory

Place in Patran Files

Process for running JMP:

Analyze->FitModel....remove all ‘Y’ but one

Set personality to ‘Stepwise’-> RunModel -> Go

->Make Data Table->extract ‘Estimates’ and use as coefficients
->MakeModel->Run Model with Standard Least Squares
Record ‘RMS of Error’ and ‘R2 adjusted’

->Save Columns->Predicted Values

->Save Columns->Residuals

Process for running Monte Carlo (Matlab version):

Enter predictions for DragDuration, maxDensity, velocity, and (period) into

“RespSurf Driver ODY.m”

Make sure ‘RSEdata’ in “RespSurfTemp ODY.m” is completely up to date by referring to notes
Note the thermal model correlation error data!-use JMP error and std’s for first three orbits and
then recalculate an error and std based on results

Set the number of samples

Note: check density range and Period to IT equation
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